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DETAILED LESSON OUTLINE

COURSE I-Suite

UNIT 1.0 — Course Overview.

SUGGESTED TIME 10 minutes

TRAINING AIDS Compute_r projector, screen, and Power Point
presentation.

OBJECTIVES Ubr:on completion of this unit, the trainee will be
able to:

1. Identify course organization and topics.
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WELCOME EVERYONE.
INTRODUCE INSTRUCTORS.
HAVE TRAINEES INTRODUCE THEMSELVES.
PASS AROUND STUDENT SIGN IN SHEET.
COVER HOUSEKEEPING AND FACILITIES.

I. INTRODUCTION

NOTE: The Introduction Unit is not "hands on." The
information for this section is explained in a Power Point
presentation.
A. Transportation.

1.  Who needs rides to lunch, hotel, etc.?

2. Facilities: Restrooms, drink and snack locations,
emergency exits.

Lunch and break schedule.

Telephones and where emergency messages can be
left.

B. Time Frames.

INSTRUCTORS SET DAILY START AND STOP TIMES, LUNCH
BREAKS, ETC.

1. Thereisa lot to cover.
2. Class will start at the time specified.
C. Unit Topics.

1. The following topics are covered in this training
manual:

a. 1.0 - Course Overview
b. 1.1 - Security for I-Suite
c. 1.2 — Getting Started with I-Suite
d. 1.3-—-Common Features
e. 1.4 —I-Suite Options
f. 1.5 —Working with grids and tables
g. 1.6— I-Suite Modules
D. Course Overview.
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This is not a pass/fail class.

The training manual is divided into separate units
corresponding to the modules.

Handouts are located at the end of each unit.
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COURSE: I-Suite

UNIT: 1.1 - Security for I-Suite

SUGGESTED TIME: 30 minutes

TRAINING AIDS Computer projector, screen, and Power Point
presentation. Access to the 1-Suite Website, if it
is available.

OBJECTIVES Upon completion of this unit, the trainee will be
able to:

1. Learn the Rules of Behavior to which
you must adhere.

2. ldentify the key I-Suite security
principles.

3. Understand that I-Suite may contain
P1I Data and how that data is protected.

4. Understand I-Suite user accounts.
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INTRODUCE THE UNIT.

PRESENT UNIT OBJECTIVES.
I. RULES OF BEHAVIOR
A. All I-Suite users must understand and follow the Rules

of Behavior, the security principles and practices, and
know and practice their responsibilities regarding I-Suite
security.

NOTE: Some Incident Management Teams have a Rules of
Behavior document that must be read and signed.

B.

It is everyone's responsibility to safeguard the
information that is collected, stored and maintained by
the I1-Suite application.

The Rules of Behavior do not replace but enhance
existing agency policies.

Users are to work within the confines of their authorized
access or role. Users should not attempt to access other
modules or screens in the I-Suite application to which
they do not have authorization. User accounts and
additional roles can be granted by a user with a

DB Admin role, which is usually the incident Computer
Technical Specialist (CTSP).

Security violations include, but are not limited to:
Sharing of user name and password pairs.

Sharing I-Suite information or data with individuals
who do not have an official need to know.

Violating any other security policy or procedure.

If you leave your computer for any period of time, close
the 1-Suite application. This will ensure that no
unauthorized person can access the I-Suite application
while you are away.

Il. I-SUITE SECURITY PRINCIPLES
A. A user must have an active user account in an I-Suite

database in order to log into the I-Suite application and
access that database. The only exception to this rule is
during the initial setup procedure when an initial DB
Admin account is created.

B. Only a user with a DB Admin role can create User

<4—Instructor Comments
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4—Read Note
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Accounts. In most cases, this is the incident CTSP at the
Incident.

C. Each user must be assigned a unique user name and
password to log into a database within the I-Suite
application.

D. A user cannot use the same user account to log into the
same database at the same time, unless they have a DB
Admin role.

E. Backing up the I-Suite database is crucial and should be
done on a regular basis. The I-Suite application includes
an automatic backup feature that allows the CTSP to
backup the database as often as needed. For more
information on backups, refer to the I-Suite Database
Admin Training Manual.

F. I-Suite databases should NOT be distributed to anyone
except those outlined in other policies (e.g. to
transitioning team, owning unit, or authorized
personnel).

G. Before logging into I-Suite you must read and agree to
the security statement that displays.

H. Only authorized personnel can attach a repository
database file. The repository database file does not use
the same password as the database used to create it.

I.  You must have a DMS User Name and DMS Password
to upload the repository and other export files on the I-
Suite Web site (http://isuite.nwcg.gov).

J. You must enter the database password to perform the
following processes:

e Attach a database

e Detach a database

e Restore a database from a backup
e Copy a database

e Rename a database

e Merge databases

] Database passwords never
K. When you create a new database, you MUST provide a lexpire due to the portable

password for the database. The requirements for the nature of I-Suite Databases.
database password are:
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OUTLINE
1. Must contain a minimum of 12 characters.
2. Must contain at least 1 lowercase letter.
3. Must contain at least 1 uppercase letter.
4. Must contain at least 1 number.
5. Must contain at least one of the following special
characters:
I#%&*N
6. Cannot be a dictionary word.
I11. PIl Data

A. PIl data is Personally Identifiable Information.

B. The I-Suite application limits access to data based on
roles assigned to User Accounts. A user can only access
data that is relevant to their assigned role.

C. The I-Suite database may contain PII data, such as Social
Security Numbers (SSN), Tax Identification Numbers(
TIN), address and phone information.

D. The SSN and TIN are encrypted in the database and are
never visible to the user in I-Suite. Data entry is masked
with asterisks and must be entered twice for verification.

E. All data export files are encrypted for security purposes

to protect P1l and other sensitive data.

1. Understand I-Suite User Accounts

A

I-Suite user accounts consist of a unique user name and
password set. They are specific to each database and the
same account may be used in multiple databases.

A user name must be 1 to 20 characters in length and
cannot be "admin.” The user name usually consists of the
first letter of the user's first name and their last name
(e.g. John Doe is jdoe).

User names must be unique to the database, regardless of
the case that is used. For example, jdoe and JDoe are
considered the same user name.

When you change your password for any reason, your
password:

1. Must contain a minimum of 12 characters.
2. Must contain at least 1 lowercase letter.
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Must contain at least 1 upper case letter.
Must contain at least 1 number.

Must contain at least one of the following special
characters:

1#%&*N
6. Cannot be a dictionary word.

7. Cannot be one of the last 24 passwords defined for
your account.

E. The first time you log into the I-Suite application, you
must change your password.

F. You must change your password when it is reset by an
administrator (usually the incident CTSP).

G. Passwords are case sensitive.

H. If you fail to login with a correct password 5 consecutive
times, your user account will be locked.

I.  If your User Account is locked, you must contact your
local 1-Suite Administrator (CTSP) to unlock your
account.

J. The password for your User Account in I-Suite will
expire 60 days for the last date the password was set or
reset.

K. A message will display 3 days prior to the expiration
indicating that your password is about to expire. You
have the option to change the password at that time or
wait.

L. Once your password is expired, you will be prompted to
change it the next time you log into I-Suite. You must
change your password or you cannot access the I-Suite
application.

M. You can change your password any time in I-Suite by
selecting the Tools menu and the Change Password
option.

N. If no users with a DB Admin role can access the I-Suite
application, contact the Help Desk.

REVIEW UNIT OBJECTIVES. <4—Instructor Comment
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COURSE: I-Suite

UNIT: 1.2 - Getting Started with I-Suite

SUGGESTED TIME: 20 minutes

TRAINING AIDS Computer projector, screen, and Power Point
presentation. Access to the 1-Suite Website, if it
is available.

OBJECTIVES Upon completion of this unit, the trainee will be
able to:

1. ldentify the components of the I-Suite
application.

2. ldentify the different methods to obtain
help for the 1-Suite application.
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INTRODUCE THE UNIT.

PRESENT UNIT OBJECTIVES.

HELP

A. There are several methods you can use to receive Help
for the 1-Suite Application:

1.

6.
NOTE

Help is available within the I-Suite application. To
access the 1-Suite Application Help, select the Help
drop-down menu at the top of any I-Suite window.
When the sub-menu displays, select the 1-Suite Help
option.

The I-Suite Website (http://isuite.nwcg.gov) contains
a wide variety of I-Suite documentation, including:

a. Software Downloads
b. Updates
c. User Guides
d. Quick Reference Cards
e. Training Material

f.  Other User Documentation
Contact your incident CTSP.

I-Suite User Guides include information on using the
different modules within I-Suite. These are available
in a PDF format on the I-Suite Website
(http://isuite.nwcg.gov).

The Training Materials demonstrate how to use the
I-Suite system. These are also available in a PDF
format on the 1-Suite Website
(http://isuite.nwcg.gov).

For additional help, contact the 1-Suite Helpdesk.

: Contact information for the I-Suite HelpDesk is

available by selecting the Support option listed under the
Help Menu in I-Suite.

I-Suite Components

A. I-Suite is comprised of the following modules:

1.

Database Admin

<4—Instructor Comments
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Data Admin
Resources
Demob
Incident Action Plan
Time
Cost
Custom Reports
Supply

10. Injury/lliness
REVIEW UNIT OBJECTIVES. <4—Instructor Comment
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COURSE

UNIT:

SUGGESTED TIME:

TRAINING AIDS

OBJECTIVES

DETAILED LESSON OUTLINE

I-Suite
1.3 — I-Suite Common Features.
15 minutes

Computer projector, screen, and Power Point
presentation.

Upon completion of this unit, the trainee will be
able to:

1. ldentify the common features of the I-
Suite application.
a. Menus.
b. Main I-SuiteToolbar.
c. Resource Filter buttons.
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INTRODUCE THE UNIT.

PRESENT UNIT OBJECTIVES.
. COMMON FEATURES
A. There are many features within I-Suite that are common

to most of the modules. These features include:
1.

The following drop-down menus are available at the
top of each window in the I-Suite system:

a. File menu
b. Modules menu
c. Filters menu
d. Reports menu
e. Tools menu

f. Help menu

Module Buttons are located on the left side of the
Main toolbar. Click these buttons to open the
indicated module.

Action Buttons are located on the right side of the
Main toolbar. These buttons allow you to Add, Edit
and Delete entries in the I-Suite system. These
buttons also enable you to Preview and Print reports
and Refresh the window.

Identify the Incident on the top right side of the I-
Suite window.

Il. FILTERS AND GRID

A.

1.

Identify where the Filters and Grid are located:

The Filter toolbar is located beneath the Main
toolbar. Click the buttons in this toolbar to filter the
Resources grid by Aircraft, Crews, Equipment,
Overhead, All Personnel, or display All records.

The Filter Bar is located above the Resources grid.

Exclude Demobed is located next to the Filter
buttons.

Exclude Filled is located under Exclude Demobed.

The Resources grid is located in the center portion of
the window, beneath the toolbars. If a plus sign (+)

<4—Instructor Comments

1.0-13-ISUITE-EP

1.0-14-ISUITE-EP

I-Suite Version 12.01.00 Introduction 1.3-2



OUTLINE

AIDS & CUES

displays next to a resource, click the plus sign to
display subordinate resources.

NOTE: The Resources grid displays on most, but not all, I-
Suite windows.

NOTE: Depending on which module is open, there may be
additional buttons and checkboxes.

1. I-SUITE MENUS

A

1.

E.

1.

N o g b DN E

Identify File menu items.

Open Database - Open an incident database in |-
Suite.

Print - Print a report.
Refresh Data - Refresh the data on your window.
Exit - Close the I-Suite application.

Select an option from the Modules drop-down menu to
open that module in the I-Suite system.

Select an option from the Filters drop-down menu to
filter the Resources grid.

Identify the type of Reports you can print from the
Reports menu:

Cost Reports

Demob Reports

Plan Reports

Supply Reports

Time Reports
Custom Reports
Injury/lliness Reports

Identify Tools menu items.

Options - Define various I-Suite settings.

NOTE: The settings you can change in Options depends on

the permissions that are assigned to you in the I-Suite system.

2.

3.

Quick Stats - Quickly view Stats in the I-Suite
system.

Change Password - Change your I-Suite password.

4—Read Note

4—Read Note
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F. ldentify Help menu items.

1. 1-Suite Help - Opens Help information for the 1-Suite

application.
2. About - Displays version information for I-Suite.

3. Support - Displays contact information for the
HelpDesk.

NOTE: The Time, Cost and Supply modules have their own

menus that display when you are in those modules. The
functions within those menus are relevant to the selected
module (i.e. under the Cost menu is Graphs, Accruals, etc.)

REVIEW UNIT OBJECTIVES.

I-Suite Version 12.01.00 Introduction
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COURSE: I-Suite

UNIT: 1.4 — 1-Suite Options.

SUGGESTED TIME: 15 minutes

TRAINING AIDS Compute_r projector, screen, and power point
presentation.

OBJECTIVES pr;on completion of this unit, the trainee will be
able to:

1.  Select options in the I-Suite application.
2. Change grid colors.

3. Select columns to display.

4

Change the order in which grid columns
display.
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INTRODUCE THE UNIT.

PRESENT UNIT OBJECTIVES.

OPTIONS

A. Identify options to use in the I-Suite application.
NOTE: The options you can change are based on the rights
assigned to you in the I-Suite system.

NOTE: All customizations are specific to the user. Each user

account can apply their own customized views for each

module.

GRID SETTINGS
A. Change Grid colors.
NOTE: Color changes apply to the grids in all modules.
1. Colors for the grids can be changed on the General

tab on the Options window.
You can select a different color for each Grid Area.

3. Double click the Color Box to open the Color
Palette.

4.  When you change the color, you can preview the
change under the Grid Colors area on the General
tab.

NOTE: Access the Options window from the Tools menu.
B. Identify the grid columns to display and the order in
which to display them.

1. ldentify the grid columns to display on the Options
window.

2. Grid columns can be defined for each module in I-
Suite.

3. The columns that are available for the grid display
under Resource Grid Columns.

4, The columns with checkmarks next to them are the
ones that display in the grid.

5. The order in which the columns display in the grid is
the same order in which they display under Resource

<4—Instructor Comments
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Grid Columns.

NOTE: You can change the order of the columns in the grid
by dragging them to a different position under Resource Grid
Columns.

C. Show the Data Saved Message Box.

1. If the checkbox Show Data Saved Message Box is
checked on the General tab on the Options window,
the Data Saved message displays when the Save
button is clicked on a window.

2. If the checkbox Show Data Saved Message Box is
not checked, the Data Saved message does not
display when the Save button is clicked on a window.

D. Format T-Card Labels.

1. T-Card labels can be formatted on the
Resources/Labels tab on the Options window.

NOTE: A special printer must be defined to print T-Card labels.
I1l. RESOURCE OPTIONS

A. Other column titles in the Resources grid:

1. Other column titles for the Resources grid can be
changed on the Resources tab on the Options
window.

2. Use the box next to the default Other column title to
change the title (i.e. to change the name of the Other
1 column, enter the new name in the box next to
Other 1).

NOTE: When the title for the Other columns are changed on
the Resources tab in Options, the changes are saved to the
database. This means that all users will see the changes.

B. Additional kind codes for QuickStats:

1. Additional Kind Codes for QuickStats can be
defined on the Resources tab on the Options
window.

2. The Kind/Position drop-down contains a list of kind
codes you can add to QuickStats.

3. When you add a new code, it displays in the
Additional Kinds used for QuickStats grid.

NOTE: When you add additional kind codes for QuickStats,

4—Read Note

4—Read Note

4—Read Note

4—Read Note

the changes are saved to the database. This means that all
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users will see the changes.

C. Each user can identify the Default Checkin Date and
Time they want to use in I-Suite.

1. Define the Default Checkin Date and Time on the
Resources tab on the Options window.

2. You can set the the Default Checkin Date and Time
to one of the following:

e System Date - Select this option to
automatically use the system date and time
for the Check-in.

e Blank - Select this option leave the Check-
In Date and Time blank.

REVIEW UNIT OBJECTIVES. <4—Instructor Comment
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COURSE: I-Suite

UNIT: 1.5 — Working with Grids.

SUGGESTED TIME: 15 minutes

TRAINING AIDS: Compute_r projector, screen, and power point
presentation.

OBJECTIVES Ub;ion completion of this unit, the trainee will be
able to:

1. Work with grids in the I-Suite
application.

2. Filter resources.
3. Sort resources.
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INTRODUCE THE UNIT.
PRESENT UNIT OBJECTIVES.
I. GRIDS
A. Work with grids in the I-Suite application.
B. Filter Resources
C. Sort Resources
NOTE: The Grids that display in I-Suite depend on the
module that is open.
Il. FILTER RESOURCES
A. Filter Buttons:
SHOw THE LOCATION OF THE FILTER BUTTONS.

1. All - Displays all resources in the grid.
Aircraft - Only displays aircrafts in the grid.
Crews - Only displays crews in the grid.
Equipment - Only displays equipment in the grid.

o r W

Overhead - Only displays overhead resources in the
grid.

6. All Personnel - Only displays personnel in the grid.

NOTE: A Leader column displays in the grid when the All
Personnel filter is selected. A checkmark in this column
identifies the resource as a leader.

B. Filter Bar:

SHOW THE LocATION OF THE GRID FILTER BAR AND THE
FILTER INPUT BOXES WHERE YOU CAN ENTER FILTER
CRITERIA.

NOTE: You do not have to enter an entire search term. When
you enter the first few characters of a term for any column, all
entries that begin with those characters display in the grid.

1. Filter terms are entered in the Filter boxes above the
columns in the grid.

2. When defining a filter, you only need to type one or
two characters in the Filter box. I-Suite filters the grid
as you type.

<4—Instructor Comments
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EXAMPLE: To search for all resources with a name
that begins with the letter S, type that letter in the
Filter box above the Name column.

3. Use the Clear Filter Bar button to clear any filters
entered in the Filter Bar.

I1l. SORT RESOURCES
A. Column Headings:

1. When you click a column heading in the grid, the
entries are sorted by that column.

2. You can sort the grid in either Ascending or
Descending order. When you click the column
heading once, it is sorted in Ascending order. Click it
again to sort it in Descending order.

EXAMPLE: To sort grid data by request number,
click the Request Number column heading. If the
data is in Ascending order and you want to display it
in Descending order, click the column heading a
second time.

B. Multiple Sorts:

1. You can use multiple sorts for the data in the grid. For
example, you could click the Overhead button. Then
enter S in the filter bar above the Name column and
FS above the Agency column. Then click the Kind
Desc heading to sort the column in ascending order.

NOTE: To use multiple columns to sort the data in the grid,
hold down the Shift key and click each column heading you
want to include in the sort.

4—Read Note

C. Print the Sorted/Filtered Grid.

1. If you want to print a filtered/sorted grid, you would
first need to Filter the grid. Then Sort it in the
appropriate order.

2. When you click the Print button in the Main toolbar,
a report with the filtered grid is sent to your default
printer.

REVIEW UNIT OBJECTIVES. 4—Instructor Comment
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COURSE: I-Suite

UNIT: 1.6 — 1-Suite Modules.

SUGGESTED TIME: 15 minutes

TRAINING AIDS Compute_r projector, screen, and power point
presentation.

OBJECTIVES Ub;ion completion of this unit, the trainee will be
able to:

1. ldentify how roles determine access to
each of the 1-Suite modules.

2. ldentify the I-Suite modules.

I-Suite Version 12.01.00 Introduction 1.6-1
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INTRODUCE THE UNIT.

PRESENT UNIT OBJECTIVES.
. USER ROLES

A

1.

A

1.

Identify how roles determine access to each of the I-
Suite modules.

Access to each of the I-Suite Modules is determined
by the user's assigned role. A User's role may include
access to multiple modules (e.g. Resources and Time).

Il. I-SUITE MODULES
Identify the function of the I-Suite Modules:
ExPLAIN THE FuNCTION OF EACH OF THE I-SUITE MODULES.

Database Admin - This module is used to Manage
the Database. Access this module from the Modules
drop-down menu. The following Action buttons
display on the left side of the window:

a.

@ = o o o

Attach - attaches databases to the I-Suite
application.

Detach - detaches database from the I-Suite
application.

Backup - backs up the databases.

Restore - restores a backup database.
Copy/New DB - creates and copies databases.
Rename - renames a database.

Create Repository - creates a data repository
file that can be uploaded to the repository site.

Purge SSN/EIN - changes all social security
numbers and EINs to 9's.

Import Data - imports data into I-Suite.

Export Data - creates export data files from I-
Suite.

IMS - merges databases.

Users - sets up I-Suite users and defines their
permissions in the 1-Suite system. There are two
levels of users - Admin (server rights), and I-
Suite (database rights). An Export and Import

<4—Instructor Comments
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option are available to move users between
databases.

NOTE: A unique user name and password must be defined
for each user in the database.

2. Data Admin - All incident data and lookup tables are
managed through the Data Admin Module. Use the
options in this module to:

a. Define incidents in I-Suite.
b. Manage accounting codes.
c. Define non-standard lookup tables.

3. Resources - The Resources Module is the primary
data entry point for I-Suite. Keep the following points
in mind when using the Resources module:

a. The Add/Edit screen can be accessed from
each module.

b. Enter Common Data for each resource in the
area just beneath the Resources grid.

c. Module tabs display at the bottom of the
Resources window. The tabs that display are
based on the permissions that the user has in I-
Suite.

4. Demob - The Demob module provides additional
fields and reports for demob planning, reassignment
and release.

a. Use the Action buttons - P (Group Pending), D
(Group Demob), and N (No Grouping) - on the
left side of the Demob toolbar to change the
status assigned to resources. Use the other
buttons to generate Demob reports.

b. The Default Data from check-in displays in the
area on the left side of the window.

c. Tentative Release information is defined in the
center section on the Demob window.

d. Actual Release information is defined in the
area on the right side of the window.

5. 1AP - The IAP module utilizes the I-Suite database to
create several of the ICS forms.

4—Read Note

1.0-24-ISUITE-EP
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a. Use the buttons in the AP toolbar to create and
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maintain ICS forms.
b. Forms created in IAP display in the Tree View.

c. The user can create the following ICS forms in
IAP: 1CS202, 1CS203, 1CS204, 1CS205,
ICS206 and 1CS220.

6. Time - The Time Module allows the user to manage
time records, create payment documents and reports. 1.0-28-ISUITE-EP
Use this module to:

a. Post personnel, crew, and contract time.
b. Post commissary adjustments.

c. Edit roster data.

d. Printinvoices (OF-286 and OF-288).

7. Cost - The Cost Module is a tool to analyze and
report cost data. Use this module to:

1.0-29-ISUITE-EP

a. Generate daily cost records.
b. View daily cost records.
c. Edit daily cost records.

8. Custom Reports - Custom reports may be created ~ [1.0-30-ISUITE-EP
using the Report Designer or by using the Advanced
Designer.

a. Report Designer: Use pre-defined views and
fields to design and run reports.

b. Advanced Designer - Use SQL statements to
design and run reports.
9. Supply - The Supply Module allows the user to: 1.0-31-ISUITE-EP
a. Track, issue and return items for resources and
locations.

10. Injury/lliness - The Injury/lliness module allows the 1.0-32-ISUITE-EP

user to:

a. Track injuries, illnesses and prevention for an
incident.

REVIEW UNIT OBJECTIVES. “4—Instructor Comment
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